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0 EVLA_MandC 349.8 wks? Jan 1 '02 Oct 7 '08 55%
1 Global Tasks 48 wks May 1 '06 Apr 12 '07 0%
2 Antenna sleuthing 4.05 mons May 1 '06 Aug 21 '06 0% Barry Clark[33%],Ken Sowinski[50%],Walter Brisken[25
3 VLA maintenance & troubleshooting 12 mons May 1 '06 Apr 12 '07 0% Ken Sowinski[10%]
4 EVLA M&C SW Dev Plan (MS Project Ver) 2 mons Jun 1 '06 Jul 26 '06 0% Bill Sahr[10%]
5 EVLA M&C Design document 2 mons Jun 1 '06 Jul 26 '06 0% Bill Sahr[15%]
6 Correlator face2face (Soc) 4 days Oct 23 '06 Oct 26 '06 0%
7 EVLA M&C CDR 2 days Nov 14 '06 Nov 15 '06 0% 4FS-4 wks,5F
8 SSS (Science Support System) PDR 2 days Mar 13 '07 Mar 14 '07 0%
9 EVLA SCIENCE Advisory Comm Mtng 2 days Apr 9 '07 Apr 10 '07 0%
10
11 Transition System, Retirement of Modcomps 284 wks? Jan 1 '02 Jun 25 '07 74%
12 General Capabilities 65.6 wks? Dec 5 '05 Mar 19 '07 75%
13 Antenna Checkout/Acceptance Software 13.8 wks? May 1 '06 Aug 3 '06 81%
14 Items needed while Modcomps still prese 9.6 wks May 30 '06 Aug 3 '06 83%
15 CLI version 6 wks May 30 '06 Jul 10 '06 100% Bryan Butler[10%],Peggy Perley[5%]
16 GUI version 4 wks Jul 7 '06 Aug 3 '06 56% Bryan Butler[10%],Peggy Perley[5%]
17 Items needed when Modcomps are retired 0.2 wks? May 1 '06 May 1 '06 0%
18 Reference Pointing 32.4 wks Dec 5 '05 Jul 18 '06 100%
19 Interim Obs Executor modifications 9.4 wks Dec 5 '05 Feb 7 '06 100% Barry Clark[20%]
20 Obs2script modifications 4 wks Jan 2 '06 Jan 27 '06 100% Bryan Butler[10%]
21 Single Ref Ptging tested & verified 23 wks Feb 8 '06 Jul 18 '06 100% 20,19
22 Double Ref Ptging tested & verified 23 wks Feb 8 '06 Jul 18 '06 100% 19,20
23 Ref Ptging Complete 0 wks Jul 18 '06 Jul 18 '06 100% 21,22
24 Use of monitor data in real time 41.4 wks Apr 11 '06 Feb 5 '07 84%
25 Ostream implemented in MIB framework SW 11 wks May 1 '06 Jul 14 '06 100% Pete Whiteis[10%]
26 Round Trip Phase (RTP) Correction 28.2 wks May 1 '06 Nov 14 '06 41%
27 L352 RTP Measurement Module 12.4 wks May 1 '06 Jul 25 '06 86%
28 L352 MIB software 2.4 wks May 1 '06 May 16 '06 100% Hichem Ben Frej[25%]
29 Ostream multicast of RTP data ena 1 day Jul 24 '06 Jul 24 '06 0% Hichem Ben Frej[1%]
30 Ostream multicast of RTP data tes 1 day Jul 25 '06 Jul 25 '06 0% 29 Hichem Ben Frej[1%]
31 Interim Obs Exec - dev listener thread & 2 wks Oct 24 '06 Nov 6 '06 0%
32 Interim Obs Executor - RTP Correction, 1 wk Nov 7 '06 Nov 14 '06 0% 31
33 Total Power & Level Setting 41.4 wks Apr 11 '06 Feb 5 '07 99%
34 T305 ostream  multicast of TP data ena 1 day Aug 14 '06 Aug 14 '06 100% Pete Whiteis[1%]
35 T305 ostream multicast of TP data teste 1 day Aug 15 '06 Aug 15 '06 100% 34 Pete Whiteis[1%]
36 Level Setting Strategy Agreed Upon 3 wks Apr 11 '06 May 1 '06 100%
37 Automated Level Setting implemented 2 wks Aug 15 '06 Aug 28 '06 100% 34 Barry Clark[5%],Walter Brisken[5%],Ken Sowinski[5%]
38 Automated Level Setting Tested 1 wk Aug 29 '06 Sep 4 '06 100% 37 Barry Clark[5%],Walter Brisken[5%],Ken Sowinski[5%]
39 HW (TP detectors) in place for AC & BD 0 wks Feb 5 '07 Feb 5 '07 50%
40 Weather Data (from CMP) 0.4 wks Jul 24 '06 Jul 25 '06 0%
41 Ostream multicast of weather data enab 1 day Jul 24 '06 Jul 24 '06 0% Hichem Ben Frej[1%]
42 Ostream multicast of weather data teste 1 day Jul 25 '06 Jul 25 '06 0% 41 Hichem Ben Frej[1%]
43 Ethernet Control of EDFAs 7 wks Nov 13 '06 Jan 5 '07 0%
44 requirements & design 3 wks Nov 13 '06 Dec 5 '06 0% Pete Whiteis[5%],Rich Moeser[5%]
45 implementation 4 wks Dec 6 '06 Jan 5 '07 0% 44 Pete Whiteis[5%],Rich Moeser[5%]
46 Deformatter bandpass 6 wks Feb 5 '07 Mar 19 '07 0%
47 requirements & design 2 wks Feb 5 '07 Feb 16 '07 0% Rich Moeser[5%]
48 implementation 4 wks Feb 20 '07 Mar 19 '07 0% 47 Rich Moeser[5%]
49 Phased Array Operation 4 wks Oct 9 '06 Nov 3 '06 90% Barry Clark[10%]
50 1st & 2nd level Subarraying 0.2 wks? May 1 '06 May 1 '06 0%
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51 Scan skip or equiivalent 0.2 wks? May 1 '06 May 1 '06 0%
52 Scan extend or equiv 0.2 wks? May 1 '06 May 1 '06 0%
53 Script stop 0.2 wks? May 1 '06 May 1 '06 0%
54 Implement tipping curves for opacity determinatio 4 wks Sep 19 '06 Oct 16 '06 0% Bryan Butler[10%]
55 Write SNOW program to prevent snow accumula 2 wks Oct 30 '06 Nov 13 '06 0% Bryan Butler[10%]
56 Ability to observe fast moving sources 4 wks Nov 17 '06 Dec 18 '06 0% Barry Clark[5%]
57 M&C of EVLA Antennas 54.6 wks? Feb 1 '06 Feb 28 '07 68%
58 Obs2script development 42 wks? May 1 '06 Feb 28 '07 60%
59 Interim Obs Executor development 42 wks? May 1 '06 Feb 28 '07 60%
60 MIB software 32.5 wks? Feb 1 '06 Sep 15 '06 75%
61 module specific MIB software 32.5 wks? Feb 1 '06 Sep 15 '06 76%
62 Deformatter: complete port of MIB inter 9.2 wks? Jun 30 '06 Sep 1 '06 90% Hichem Ben Frej[20%]
63 D30x Formatter board 0.2 wks? May 1 '06 May 1 '06 30%
64 F317 FE Cntrllr, ver 1 9 wks? May 1 '06 Jun 30 '06 100% Hichem Ben Frej[20%]
65 F320 FE cntrllr 2.4 wks? Apr 17 '06 May 2 '06 100% Hichem Ben Frej[20%]
66 L302 LO Synthesizer MIB SW 26 wks Feb 1 '06 Aug 11 '06 85% Pete Whiteis[20%]
67 L353 1 wk Aug 1 '06 Aug 7 '06 0% Hichem Ben Frej[10%]
68 M301 Switch Module 2.4 wks? May 1 '06 May 16 '06 100% Hichem Ben Frej[20%]
69 M302/303 Utility Module 21.5 wks? Apr 19 '06 Sep 15 '06 40%
70 M302/303 MIB SW, Ver 1 (combin 3.8 wks? Apr 19 '06 May 15 '06 100% Pete Whiteis[15%]
71 M302/303 HW respin 4.2 wks? Aug 8 '06 Sep 5 '06 0%
72 M302/303 MIB SW, ver 2 1.5 wks Sep 6 '06 Sep 15 '06 0% 71 Pete Whiteis[10%]
73 T304/305 Downconverter 26 wks Feb 1 '06 Aug 11 '06 70% Pete Whiteis[25%]
74 P301 Pwr Supply 2 wks Jun 26 '06 Jul 7 '06 0%
75 framework, data port, service port 0.2 wks? May 1 '06 May 1 '06 0%
76 in use flag 0.2 wks? May 1 '06 May 1 '06 0% Hichem Ben Frej[5%],Bill Sahr[5%]
77 packet sequence #s 0.2 wks? May 1 '06 May 1 '06 0%
78 Visibility data distribution (Visibility Pipe) 44 wks? Mar 3 '06 Jan 12 '07 79% Ray Ferraro[25%],Bruce Rowen[15%]
79 decision on approach 12 wks? Mar 3 '06 May 25 '06 100% Ray Ferraro[20%]
80 hardware development 12.8 wks Aug 31 '06 Dec 1 '06 90% Ray Ferraro[40%]
81 Initial HW  tests 1 day Dec 7 '06 Dec 7 '06 0% 80 Ray Ferraro[50%],Ken Sowinski[50%]
82 HW regularly avail for SW development 0 wks Dec 7 '06 Dec 7 '06 0% 81
83 Software Development 4.6 wks Dec 8 '06 Jan 12 '07 0%
84 modifications to VME SBC & AP software 3 days Dec 11 '06 Dec 13 '06 0% Ken Sowinski[25%]
85 PC104 systems software (at site) 1 wk Dec 8 '06 Dec 14 '06 0% 82 Pete Whiteis[10%]
86  applications software development & testing 3 wks Dec 20 '06 Jan 12 '07 0% Pete Whiteis[40%]
87 Visibility data avail to EVLA M&C System 0 wks Jan 12 '07 Jan 12 '07 0% 86
88 VLA format archive records (IDCAF) 90.8 wks May 2 '05 Feb 5 '07 68%
89 Definition of archive format 13.6 wks May 2 '05 Aug 3 '05 100% Ken Sowinski[10%]
90 Control script extensions 8 wks Sep 29 '06 Nov 28 '06 75% ?
91 Obs2script extensions needed by IDCAF 8 wks Sep 29 '06 Nov 28 '06 75% Bryan Butler[10%]
92 Executor extensions needed by IDCAF 8 wks Sep 29 '06 Nov 28 '06 75% Barry Clark[30%],Ken Sowinski[5%]
93 IDCAF software 14 wks Sep 29 '06 Jan 12 '07 40% 92SS Walter Brisken[50%]
94 IDCAF testing of deployed final version 3 wks Jan 16 '07 Feb 5 '07 0% 89,91,92,93,8
95 VLA format archive records written by EVLA M&C 0 wks Feb 5 '07 Feb 5 '07 0% 94
96 Operator training - Modcomp Repl System 5.2 wks? Feb 21 '07 Mar 28 '07 0%
97 initial training 2 wks Feb 21 '07 Mar 6 '07 0% 95FS+2 wks
98 documentation 0.2 wks? Mar 7 '07 Mar 7 '07 0% 97
99 refinement of training & documentation 3 wks Mar 8 '07 Mar 28 '07 0% 98
100 operators able to bring up Modcomp Repl System 0 wks Mar 28 '07 Mar 28 '07 0% 99
101 M&C of VLA Antennas 49.4 wks? Mar 1 '06 Feb 20 '07 89%
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102 Obs2script mods 6 wks Nov 13 '06 Dec 28 '06 60% Bryan Butler[10%]
103 Initial Interim Obs Exec mods 13 wks Mar 1 '06 May 30 '06 100% Barry Clark[20%]
104 CMP capabilities ready 48 wks? Mar 1 '06 Feb 8 '07 98%
105 Initial Software completed 13 wks? Mar 1 '06 May 30 '06 100% Hichem Ben Frej[50%],Barry Clark[25%]
106 Initial CMP tests complete 4 wks Jul 10 '06 Aug 4 '06 100% Barry Clark[5%],Hichem Ben Frej[5%]
107 Ability to handle 23 VLA Antennas evalua 37.2 wks May 16 '06 Feb 8 '07 92%
108 Simulation complete 6.8 wks May 16 '06 Jun 30 '06 100% Hichem Ben Frej[10%]
109 Full test 3 days Feb 6 '07 Feb 8 '07 0% 114SS Hichem Ben Frej[10%]
110 VLA parameters added to EVLA parametrs da 4 wks Jun 15 '06 Jul 12 '06 90% Ken Sowinski[10%]
111 Software to convert from system files to dba 3 wks Jun 15 '06 Jul 5 '06 90%
112 Software tests 1 wk Jul 6 '06 Jul 12 '06 90% 111
113 Parameters dbase updated for VLA antenna 0 wks Jul 12 '06 Jul 12 '06 0% 112
114 Final Tests/Debug of Control of VLA Antennas 2 wks Feb 6 '07 Feb 20 '07 0% 87,95
115 EVLA Control of VLA Antennas complete 0 wks Feb 20 '07 Feb 20 '07 0% 114
116 M&C of VLA Correlator 272 wks? Jan 1 '02 Mar 29 '07 83%
117 New correl cntrllr operational, Modcomp cont 261 wks? Jan 1 '02 Jan 9 '07 97%
118 Correl Cntrllr HW & SW 247 wks? Jan 1 '02 Sep 26 '06 100%
119 Correl Cntrllr - HW & SW devlopment 245.8 wks? Jan 1 '02 Sep 15 '06 100% Ken Sowinski[25%],Bruce Rowen[25%],Ray Ferraro[25
120 AP - Boss communication robustness 6.2 wks? Aug 4 '06 Sep 15 '06 100%
121 initial certification of science data 0 wks Sep 26 '06 Sep 26 '06 100% Gustaaf van Moorsel[10%]
122 long term test 10 wks Sep 26 '06 Dec 7 '06 50% 118
123 ongoing examination & certification of sci da 14 wks Sep 26 '06 Jan 9 '07 69% 122SS Gustaaf van Moorsel[20%]
124 VLA Correlator Config & Control Screens 54.4 wks? Mar 3 '06 Mar 29 '07 48%
125 basic control & config screens (rscreens pkg 26 wks? Mar 3 '06 Aug 31 '06 100% Bruce Rowen[5%]
126 correct  omission of Multiplier & Delay errors 2 wks? Nov 6 '06 Nov 20 '06 0% Bruce Rowen[5%]
127 install system with more memory to ease scr 8 wks? Nov 6 '06 Jan 17 '07 0% Bruce Rowen[5%]
128 ? Converts rscreens to use statically allocate 6 wks Feb 15 '07 Mar 29 '07 0% 127FS+4 wks Bruce Rowen[5%]
129 Screen(s) for correlator derived self-products 4 wks? Sep 11 '06 Oct 6 '06 0% ?
130 miscellaneous loose ends 8 wks Sep 26 '06 Nov 21 '06 0% 122SS
131 operator documentation & training 8 wks Sep 26 '06 Nov 21 '06 50% 122SS
132 new correlator controller in regular use 0 wks Sep 26 '06 Sep 26 '06 0% 122SS
133 New correlator cntrllr under EVLA M&C Contr 16.8 wks? Oct 30 '06 Mar 6 '07 38%
134 Obs2script mods 6 wks? Nov 13 '06 Dec 28 '06 50% 122SS+4 wks Bryan Butler[10%]
135 Interim Obs Exec mods 6 wks? Oct 30 '06 Dec 13 '06 50% 122SS+4 wks Barry Clark[25%]
136 initial test 1 day Nov 13 '06 Nov 13 '06 100%
137 testing, VLA Correl under EVLA control 4 wks Feb 6 '07 Mar 6 '07 0% 95
138 VLA correlator controlled by EVLA M&C sys 0 wks Mar 6 '07 Mar 6 '07 0% 137
139 Correl Cntrllr, spare boards 12 wks Dec 4 '06 Mar 2 '07 0% Ray Ferraro[20%]
140 ITelcal 107.6 wks? Feb 14 '05 Mar 19 '07 85%
141 Initial requirements & design 43 wks? Feb 14 '05 Dec 9 '05 100% Ken Sowinski[20%]
142 Antenna Gains (Antsol) 13.2 wks Dec 5 '05 Mar 6 '06 100% 141 Chunai Cai[50%]
143 Pointing Offsets 13.2 wks Dec 5 '05 Mar 6 '06 100% 141 Chunai Cai[50%]
144 Focus Settings 6 wks Feb 5 '07 Mar 19 '07 0%
145 Delays 6 wks Feb 5 '07 Mar 19 '07 0%
146 Flagging 84 wks? Sep 21 '04 May 1 '06 71%
147 Modcomp based flagging 72.8 wks Sep 21 '04 Feb 10 '06 73%
148 EVLA flagging info sent to Modcomps 12 wks Sep 21 '04 Dec 13 '04 100% Ken Sowinski[10%],Chunai Cai[50%]
149 Revised flagger with further testing 4 wks Dec 5 '05 Dec 30 '05 100% Ken Sowinski[10%],Chunai Cai[50%]
150 Revised flagger modified based on test resu 6 wks Jan 2 '06 Feb 10 '06 0% 149
151 Modcomp-based flagging used on a regular 0 wks Dec 30 '05 Dec 30 '05 0% 149
152 EVLA based flagging 0.2 wks? May 1 '06 May 1 '06 0%
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153 Flagging info used within EVLA M&C System 0.2 wks? May 1 '06 May 1 '06 0%
154 Flagging folded into IDCAF 0.2 wks? May 1 '06 May 1 '06 0%
155 User Interfaces, Transition System 48 wks? Mar 20 '06 Feb 28 '07 44%
156 VLA Antenna Screens (AOI replacement) 15 wks Nov 6 '06 Feb 28 '07 0%
157 requirements (list of scrns & what is possible 3 wks Nov 6 '06 Nov 29 '06 0% Rich Moeser[50%]
158 development & testing to 80% complete 8 wks Nov 30 '06 Jan 30 '07 0% 157
159 remaining 20 % 4 wks Jan 31 '07 Feb 28 '07 0% 158
160 VLA Correlator Data Quality Displays 27 wks? May 1 '06 Nov 3 '06 44%
161 "F" equivalent (display of Telcal (Antsol) resu 6 wks Jul 11 '06 Aug 21 '06 90% Chunai Cai[20%],Rich Moeser[5%]
162 D10 0.2 wks? May 1 '06 May 1 '06 0%
163 Computation & Communication 0.2 wks? May 1 '06 May 1 '06 0% ?
164 Display 0.2 wks? May 1 '06 May 1 '06 0% Rich Moeser[10%]
165 P10 display 6 wks? Sep 25 '06 Nov 3 '06 0% Rich Moeser[10%]
166 ITelcal Data Quality Displays 25 wks Mar 20 '06 Sep 8 '06 100%
167 Software development complete 6 wks Mar 20 '06 Apr 28 '06 100% Chunai Cai[20%]
168 Deployed (requires some software dev) 6 wks Jul 31 '06 Sep 8 '06 100% 167 Rich Moeser[5%]
169 User Interfaces, Transition & Final System 70.6 wks Aug 1 '05 Dec 11 '06 69%
170 Array Operator Screen 70 wks Aug 1 '05 Dec 6 '06 75% Rich Moeser[50%]
171 Ancillary Screens (Screenlets) 40 wks Feb 2 '06 Nov 8 '06 75% Rich Moeser[5%]
172 EVLA Module/Subsystem Screens 44 wks Feb 2 '06 Dec 11 '06 30% Rich Moeser[15%]
173 Critical Functions Screen 8 wks May 1 '06 Jun 23 '06 1%
174 Device Browser 58 wks Aug 1 '05 Sep 8 '06 95% Rich Moeser[15%]
175 Global Issues 0.2 wks? May 1 '06 May 1 '06 20%
176 Operational tools & issues 0.2 wks? May 1 '06 May 1 '06 0%
177 enumeration of the needed tools 0.2 wks? May 1 '06 May 1 '06 0%
178 development of the tools 0.2 wks? May 1 '06 May 1 '06 0%
179 Monitor Data - Archiving & Retrieval 0.2 wks? May 1 '06 May 1 '06 50%
180 version 1 0.2 wks? May 1 '06 May 1 '06 100%
181 version 2 0.2 wks? May 1 '06 May 1 '06 0% Chunai Cai[75%]
182 Alert Subsystem 0.2 wks? May 1 '06 May 1 '06 0%
183 EVLA M&C System Controlling the Hybrid Array 12 wks Mar 30 '07 Jun 25 '07 0%
184 Operation & Testing 12 wks Mar 30 '07 Jun 25 '07 0% 57,101,116,14
185 Retire Modcomps 0 wks Jun 25 '07 Jun 25 '07 0% 184
186
187 Final System, EVLA Monitor & Control 0.2 wks? May 1 '06 May 1 '06 0%
188 General Capabilities 0.2 wks? May 1 '06 May 1 '06 0%
189 Antenna Checkout/Acceptance Software 0.2 wks? May 1 '06 May 1 '06 0%
190 Items needed when VLA corerelator retired 0.2 wks? May 1 '06 May 1 '06 0%
191 Observation Executor, final version 0.2 wks? May 1 '06 May 1 '06 0%
192 Obs2script 0.2 wks? May 1 '06 May 1 '06 0%
193 M&C of EVLA Antennas 0.2 wks? May 1 '06 May 1 '06 0%
194 EVLA Telcal 0.2 wks? May 1 '06 May 1 '06 0%
195 EVLA Flagging 0.2 wks? May 1 '06 May 1 '06 0%
196 EVLA format archive records 0.2 wks? May 1 '06 May 1 '06 0%
197 EVLA DCAF 0.2 wks? May 1 '06 May 1 '06 0%
198 EVLA Archive 0.2 wks? May 1 '06 May 1 '06 0%
199 User Interfaces 0.2 wks? May 1 '06 May 1 '06 0%
200 Widar Correlator Screens 0.2 wks? May 1 '06 May 1 '06 0%
201 WIDAR Correl - Data Quality 0.2 wks? May 1 '06 May 1 '06 0%
202 EVLA Telcal - Data Quality 0.2 wks? May 1 '06 May 1 '06 0%
203 Global Issues 0.2 wks? May 1 '06 May 1 '06 0%
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204 EVLA Alert Subsystem 0.2 wks? May 1 '06 May 1 '06 0%
205 Definition of M&C interfaces to 0.2 wks? May 1 '06 May 1 '06 0%
206 SSS software 0.2 wks? May 1 '06 May 1 '06 0%
207 Archive 0.2 wks? May 1 '06 May 1 '06 0%
208 Post Processing Software 0.2 wks? May 1 '06 May 1 '06 0%
209
210 Correlator, NRAO perspective 124 wks? May 1 '06 Oct 7 '08 6%
211 Stage 1 Protoype Hardware 124 wks? May 1 '06 Oct 7 '08 7%
212 Bruce Rowen at Penticton 3 wks Nov 14 '06 Dec 6 '06 0% 258SS+1 day
213 Kevin Ryan at Penticton 3 wks Nov 14 '06 Dec 6 '06 0% 258SS+1 day
214 Martin Pokorny at Penticton 2 wks Nov 21 '06 Dec 6 '06 0% 258SS+6 days
215 CMIBS, Gen'l Issues 0.2 wks? May 1 '06 May 1 '06 0%
216 CMIB Device Layer User's Manual (10/5/06- 0.2 wks? May 1 '06 May 1 '06 0%
217 Prototype Board Test Framework 0.2 wks? May 1 '06 May 1 '06 100%
218 CMIB<->GUI communications software 0.2 wks? May 1 '06 May 1 '06 100%
219 Specification of GUI framework technology 0.2 wks? May 1 '06 May 1 '06 100%
220 Sample GUI common look & feel 0.2 wks? May 1 '06 May 1 '06 100%
221 Gbit Transmission Test software 0.2 wks? May 1 '06 May 1 '06 100%
222 Software to load personality file into FPGA 0.2 wks? May 1 '06 May 1 '06 100%
223 Raw Register read/write software 0.2 wks? May 1 '06 May 1 '06 100%
224 Timecode Generator Board test software 0.2 wks? May 1 '06 May 1 '06 100%
225 Module Access Handler (MAH) 0.2 wks? May 1 '06 May 1 '06 100%
226 Board Top-Level GUI 0.2 wks? May 1 '06 May 1 '06 100%
227 Timecode Generator FPGA GUI 0.2 wks? May 1 '06 May 1 '06 100%
228 Raw Register Read/Write GUI 0.2 wks? May 1 '06 May 1 '06 100%
229 Baseline Board (Stage 1/Prototype) 57.2 wks? May 1 '06 Jun 18 '07 14%
230 Baseline Board Prototype Test SW 0.2 wks? May 1 '06 May 1 '06 50%
231 MAHs & Device Drivers, V1.0 0.2 wks? May 1 '06 May 1 '06 0%
232 Correlator Chip MAH 0.2 wks? May 1 '06 May 1 '06 0% Bruce Rowen[5%]
233 Recirculation Controller MAH 0.2 wks? May 1 '06 May 1 '06 0% Bruce Rowen[5%]
234 Ethernet Transmitter MAH 0.2 wks? May 1 '06 May 1 '06 0% Bruce Rowen[5%]
235 LTA Controller MAH 0.2 wks? May 1 '06 May 1 '06 0% Bruce Rowen[5%]
236 MCB Interface & Clcok Selector M 0.2 wks? May 1 '06 May 1 '06 0% Bruce Rowen[5%]
237 GUIs 0.2 wks? May 1 '06 May 1 '06 73%
238 Top Level GUI 0.2 wks? May 1 '06 May 1 '06 0% Kevin Ryan[5%]
239 Recirculation Controller GUI 0.2 wks? May 1 '06 May 1 '06 100% Kevin Ryan[5%]
240 Correlator Chip GUI 0.2 wks? May 1 '06 May 1 '06 100% Kevin Ryan[5%]
241 LTA GUI 0.2 wks? May 1 '06 May 1 '06 100% Kevin Ryan[5%]
242 Gbit Ethernet GUI 0.2 wks? May 1 '06 May 1 '06 100% Kevin Ryan[5%]
243 Recirc Cntrllr Raw Register GUI 0.2 wks? May 1 '06 May 1 '06 100% Kevin Ryan[5%]
244 Correl Chip Raw Register GUI 0.2 wks? May 1 '06 May 1 '06 100% Kevin Ryan[5%]
245 LTA Controller Raw Register GUI 0.2 wks? May 1 '06 May 1 '06 100% Kevin Ryan[5%]
246 GigE Raw Register GUI 0.2 wks? May 1 '06 May 1 '06 100% Kevin Ryan[5%]
247 Baseband Configurations GUI 0.2 wks? May 1 '06 May 1 '06 0% Kevin Ryan[5%]
248 HM Gbps Receiver GUIs 0.2 wks? May 1 '06 May 1 '06 0% Kevin Ryan[5%]
249 Baseline Board Auxiliary Data Products 23 wks? May 1 '06 Oct 6 '06 65%
250 Full definition of data products to be sav 0.2 wks? May 1 '06 May 1 '06 0%
251 Config (format, implementation) 0.2 wks? May 1 '06 May 1 '06 0%
252 LTA Frame Save (format, implementatio 5.4 wks? Aug 31 '06 Oct 6 '06 70% Bruce Rowen[5%]
253 Baseline Board Prototype, HW 18.4 wks Jun 20 '06 Oct 26 '06 100%
254 Prototype Correlator Chips delivered 0 wks Jun 20 '06 Jun 20 '06 100%
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255 PCB to manufacturere 0 wks Sep 15 '06 Sep 15 '06 100%
256 Assembled board to DRAO 0 wks Oct 25 '06 Oct 25 '06 100% 255FS+3 wks
257 Baseline Board smoke test 0 wks Oct 26 '06 Oct 26 '06 100%
258 Correl Chip & Baseline Board Testing 7.35 mons Nov 13 '06 Jun 18 '07 0% 256FS+12 day
259 Station Board (Stage 1/Prototype) 53.2 wks? May 1 '06 May 18 '07 14%
260 Station Board Data Products 12.96 wks? May 1 '06 Jul 28 '06 1%
261 data rates & data volumes 0.2 wks? May 1 '06 May 1 '06 100% Sonja Vrcic[10%]
262 enumeration & classification as monitor 10.76 wks? May 16 '06 Jul 28 '06 0% Bryan Butler[5%],Sonja Vrcic[5%]
263 Report: monitor data vs SDM, data rate 4 wks Jun 5 '06 Jun 30 '06 0% Bryan Butler[5%]
264 plotting capabilities needed for SB data 0.2 wks? May 16 '06 May 16 '06 0%
265 SB SDM data 0.2 wks? May 16 '06 May 16 '06 0%
266 spec intermediate format 0.2 wks? May 16 '06 May 16 '06 0%
267 Station Board Prototype Test SW 25 wks? May 1 '06 Oct 20 '06 61%
268 MAHs & Device Drivers, V1.0 25 wks? May 1 '06 Oct 20 '06 61%
269 Input 0.33 wks? May 1 '06 May 2 '06 75% Bruce Rowen[3%]
270 Delay 0.33 wks? May 1 '06 May 2 '06 75% Bruce Rowen[3%]
271 Autocorrelation 0.4 wks? May 1 '06 May 2 '06 75% Bruce Rowen[3%]
272 FIR Filter (changes, 10/06) 3 wks? Oct 2 '06 Oct 20 '06 60% Bruce Rowen[3%]
273 Output (changes, 10/06) 3 wks? Oct 2 '06 Oct 20 '06 60% Bruce Rowen[3%]
274 Timing (changes, 10/06) 3 wks? Oct 2 '06 Oct 20 '06 60% Bruce Rowen[3%]
275 VSI (VLBI IF - delayed, no start da 0.2 wks? May 1 '06 May 1 '06 0%
276 MCB MAH 0.2 wks? May 1 '06 May 1 '06 75% Bruce Rowen[3%]
277 Configuration MAH 0.2 wks? May 1 '06 May 1 '06 75% Bruce Rowen[3%]
278 Station Board GUIs 0.2 wks? May 1 '06 May 1 '06 100% Sonja Vrcic[50%]
279 Prototype Station Board HW 7.2 wks Sep 29 '06 Nov 21 '06 0%
280 PCB to manufacturer 0 wks Sep 29 '06 Sep 29 '06 100%
281 Assembled board to DRAO 0 wks Nov 21 '06 Nov 21 '06 0%
282 Station Board Testing 22.2 wks? Dec 7 '06 May 18 '07 0% 281FS+2 wks
283 CBE/FF Software (Stage 1/Prototype) 0.2 wks? May 1 '06 May 1 '06 0%
284 Basic capabilities (integ, FFT, archiving) 0.2 wks? May 1 '06 May 1 '06 0% Martin Pokorny[5%]
285 Ability to save lag frames (bef CBE integratio 0.2 wks? May 1 '06 May 1 '06 0% Martin Pokorny[5%]
286 Ability to save lag sets (after CBE integration 0.2 wks? May 1 '06 May 1 '06 0% Martin Pokorny[5%]
287 Real-Time Data Display (RTDD) SW (A25280N0 0.2 wks? May 1 '06 May 1 '06 0%
288 Graphical Rep of SB Output 0.2 wks? May 1 '06 May 1 '06 0% Dave Del Rizzo[15%]
289 Graphical Rep of CBE Output (RFS A25204 0.2 wks? May 1 '06 May 1 '06 0% Dave Del Rizzo[15%]
290 Prototype Correlator (PTC) 124 wks? May 1 '06 Oct 7 '08 4%
291 Binary Data Format (BDF) 42.4 wks? May 1 '06 Mar 2 '07 0%
292 Report on Alma BDF, suitability & need 5 wks Sep 27 '06 Oct 31 '06 0% Michael Rupen[15%]
293 Report on final BDF for EVLA 0.4 wks? May 1 '06 May 2 '06 0% Martin Pokorny[10%],Michael Rupen[10%]
294 Formal, written specification available 0 wks Dec 1 '06 Dec 1 '06 0% 292FS+4 wks Martin Pokorny[25%],Michael Rupen[10%]
295 First implmentation 12 wks Dec 4 '06 Mar 2 '07 0% 294SS Martin Pokorny[20%],Michael Rupen[10%]
296 Archive Records Format 34 wks? May 1 '06 Dec 29 '06 0%
297 Science Data Model 8 wks Sep 22 '06 Nov 17 '06 0%
298 Report on (A)SDM for PTC & Corr 8 wks Sep 22 '06 Nov 17 '06 0% Michael Rupen[20%]
299 UVFITS Output 4 wks Nov 30 '06 Dec 29 '06 0% 298
300 Report on adequacy of UVFITS for 4 wks Nov 30 '06 Dec 29 '06 0% Brent Carlson[5%],Bryan Butler[5%],Michael Rupen[5%
301 Decision: UVFITS or SDM for PTC ? 0 wks May 1 '06 May 1 '06 0%
302 Formal, written spec for archive records 0.2 wks? May 1 '06 May 1 '06 0%
303 Science test plan for the PTC tests 6.3 wks? Jan 2 '07 Feb 15 '07 0%
304 Science test plan for the PTC tests (dra 6.3 wks? Jan 2 '07 Feb 15 '07 0% 299 Michael Rupen[15%],Rick Perley[5%]
305 PTC Data Archive 0.2 wks? May 1 '06 May 1 '06 0%
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ID Task Name Duration Start Finish %
Complete

Predecessors Resource Names

306 Definition of the archive - NGAS, Relati 0.2 wks? May 1 '06 May 1 '06 0%
307 Archive filler software 0.2 wks? May 1 '06 May 1 '06 0%
308 Archive retrieval software 0.2 wks? May 1 '06 May 1 '06 0%
309 Post Processing 2.4 wks? May 1 '06 May 16 '06 0%
310 Comparison of S2 correlator test sw to 0.2 wks? May 16 '06 May 16 '06 0% Michael Rupen[5%],Brent Carlson[5%]
311 Adequacy of AIPS 0.2 wks? May 1 '06 May 1 '06 0% ?
312 Ability of CASA to read SDM 0.2 wks? May 1 '06 May 1 '06 0% ?
313 Ability of CASA to output AIPS compati 0.2 wks? May 1 '06 May 1 '06 0% ?
314 Post Processing avail in CASA 0.2 wks? May 1 '06 May 1 '06 0% ?
315 PTC SW RFS document (formerly: SW int 13.2 wks Oct 25 '06 Feb 2 '07 0%
316 Draft 8.6 wks Oct 25 '06 Dec 29 '06 0% Sonja Vrcic[5%],Bill Sahr[5%],Bryan Butler[5%]
317 Reviewed 0 wks Jan 4 '07 Jan 4 '07 0% 316FS+3 days
318 Revision 4 wks Jan 5 '07 Feb 2 '07 0% 317 Sonja Vrcic[5%],Bill Sahr[5%],Bryan Butler[5%]
319 Interim Observation Executor modificatio 0.2 wks? May 1 '06 May 1 '06 0%
320 Delay tracking models 0.2 wks? May 1 '06 May 1 '06 0% Barry Clark[5%]
321 Phase model generation 0.2 wks? May 1 '06 May 1 '06 0% Barry Clark[5%]
322 Dump trigger control generation 0.2 wks? May 1 '06 May 1 '06 0% Barry Clark[5%]
323 ? Other ? 0.2 wks? May 1 '06 May 1 '06 0% ?
324 Config & Control 16 wks Oct 19 '06 Feb 16 '07 0%
325 System Level GUI(s) 8 wks Oct 19 '06 Dec 18 '06 0% Kevin Ryan[5%]
326 Rack Level GUIs 8 wks Dec 19 '06 Feb 16 '07 0% 325 Kevin Ryan[5%]
327 Test Builder, Executor,Analyzer 22.6 wks Sep 4 '06 Feb 16 '07 15%
328 Reviewed RFS for Test Builder, Execut 21 days Sep 4 '06 Oct 2 '06 100% Sonja Vrcic[5%]
329 Test Configuration Builder SW 8 wks Oct 19 '06 Dec 18 '06 0% 328 Kevin Ryan[5%]
330 Test Executor SW 8 wks Oct 19 '06 Dec 18 '06 0% 328 Kevin Ryan[5%]
331 Test Analyzer (Intelligent Diff) SW 8 wks Dec 19 '06 Feb 16 '07 0% 328,329,330 Kevin Ryan[5%]
332 Real-Time Data Display (RTDD) SW (A252 0.2 wks? May 1 '06 May 1 '06 0%
333 Further Development & Refinement ? 0.2 wks? May 1 '06 May 1 '06 0% Dave Del Rizzo[10%]
334 Prototype MCCC software 0.8 wks? May 1 '06 May 4 '06 0%
335 Configuration Mapper 0.8 wks? May 1 '06 May 4 '06 0% Sonja Vrcic[25%]
336 SW to receive & pass along models 0.2 wks? May 1 '06 May 1 '06 0% ?,Sonja Vrcic[5%]
337 ? SW to receive PTC status & send to E 0.2 wks? May 1 '06 May 1 '06 0% ?,Sonja Vrcic[5%]
338 ? Proto alert generation 0.2 wks? May 1 '06 May 1 '06 0% ?,Sonja Vrcic[5%]
339 Higher Level RT CMIB SW 0.2 wks? May 1 '06 May 1 '06 0%
340 Station Brd RT delay model tracking 0.2 wks? May 1 '06 May 1 '06 0% Bruce Rowen[5%]
341 Station Brd phase model handling 0.2 wks? May 1 '06 May 1 '06 0% Bruce Rowen[5%]
342 Dump Control handling 0.2 wks? May 1 '06 May 1 '06 0% Bruce Rowen[5%]
343 ? Lower Level CMIB SW 19.2 wks? Aug 28 '06 Jan 17 '07 0%
344 CMIB Delay Models Software 8 wks? Aug 28 '06 Oct 20 '06 0% Bruce Rowen[5%]
345 CMIB Phase Models Software 8 wks? Aug 28 '06 Oct 20 '06 0% Bruce Rowen[5%]
346 CMIB Dumptrig Control 8 wks? Nov 6 '06 Jan 17 '07 0% Bruce Rowen[5%]
347 CBE & FF SW for the PTC 0.2 wks? May 1 '06 May 1 '06 0%
348 Correlator Backend (CBE) & Fast Form 0.2 wks? May 1 '06 May 1 '06 0%
349 IDCAF2 0.2 wks? May 1 '06 May 1 '06 0%
350 Requirements & Functional Spec 0.2 wks? May 1 '06 May 1 '06 0% ?
351 Architecture & Design 0.2 wks? May 1 '06 May 1 '06 0% ?
352 Implementation & Testing 0.2 wks? May 1 '06 May 1 '06 0% ?
353 PTC - DRAO Assembly & Testing 3 wks May 1 '06 May 19 '06 0%
354 Prototype Correlators Assembled & Loa 0 wks May 1 '06 May 1 '06 0%
355 Testing Workshop 3 wks May 1 '06 May 19 '06 0%
356 PTC - VLA On-The-Sky (OTS) Testing 121.8 wks? May 16 '06 Oct 7 '08 4%
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357 Revise DRAO OTS Test Plan to focus o 2.4 wks? May 16 '06 May 31 '06 100% Brent Carlson[5%]
358 HW/SW Integration Testing 17 wks? Jul 25 '07 Nov 26 '07 0% DRAO
359 Proto Correl Installation at VLA site 4 wks? Jan 2 '08 Jan 29 '08 0% DRAO,NRAO
360 DRAO OTS testing at VLA site 15 wks? Jan 30 '08 May 13 '08 0% 359 NRAO,DRAO
361 EVLA testing at VLA site 21 wks May 14 '08 Oct 7 '08 0% 360 NRAO
362
363 Correlator Networks 24.2 wks? May 16 '06 Oct 31 '06 0%
364 Correlator M&C Network 4 wks? Oct 4 '06 Oct 31 '06 0%
365 Throughput analysis 4 wks? Oct 4 '06 Oct 31 '06 0% Sonja Vrcic[10%],Brent Carlson[5%],Martin Pokorny[5%
366 Baseline Board (BB) to CBE Network 5.2 wks? Sep 26 '06 Oct 31 '06 0%
367 Throughput & node rollover analysis 5.2 wks? Sep 26 '06 Oct 31 '06 0% Sonja Vrcic[10%],Brent Carlson[5%],Martin Pokorn
368 Initial #s on BB to CBE traffic 4 wks? Sep 26 '06 Oct 23 '06 0% Martin Pokorny[5%]
369 Throughput analysis 4 wks? Oct 4 '06 Oct 31 '06 0%
370 CBE to Fast Formatter Network 24.2 wks? May 16 '06 Oct 31 '06 0%
371 Throughput analysis 24.2 wks? May 16 '06 Oct 31 '06 0% Sonja Vrcic[10%],Brent Carlson[5%],Martin Pokorny[10
372 Phasing Board 24.2 wks? Apr 14 '08 Sep 29 '08 0%
373 Assembly & Testing 24.2 wks? Apr 14 '08 Sep 29 '08 0%
374 WIDAR Correlator 31 wks? May 1 '06 Dec 6 '06 0%
375 CBE & Fast Formatter (FF) 31 wks? May 1 '06 Dec 6 '06 0%
376 CBE SW V1.0 implemented in a cluster conf 3 wks Sep 25 '06 Oct 13 '06 0% Martin Pokorny[20%]
377 Revised RFS for CBE & FF (Ver 2.0) 0.2 wks? May 1 '06 May 1 '06 0%
378 CBE & FF SW architecture & design (V2.0 31 wks? May 1 '06 Dec 6 '06 0%
379 conceptual 31 wks? May 1 '06 Dec 6 '06 0%
380 parallel filesystem investigations 12 wks Sep 11 '06 Dec 6 '06 0% Martin Pokorny[3%]
381 relationship bet CBE & FF specifie 0.2 wks? May 1 '06 May 1 '06 0% Martin Pokorny[5%]
382 relationship bet CBE/FF & archive 0.2 wks? May 1 '06 May 1 '06 0% Martin Pokorny[5%]
383 conceptual design completed 0.2 wks? May 1 '06 May 1 '06 0% Martin Pokorny[5%]
384 implementation 0.2 wks? May 1 '06 May 1 '06 0%
385 implementation design completed 0.2 wks? May 1 '06 May 1 '06 0% Martin Pokorny[5%]
386 V2.0 development & testing 0.2 wks? May 1 '06 May 1 '06 0% Martin Pokorny[5%]
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0 EVLA_MandC
Tools->Options->View: Show Project Summary Task box checked
Project start date: 6/19/2006 (Project->Project Info->Calendar) or Project->Project Info
Schedule from: project start date (Project->Project Info->Calendar)
Base calendar: EVLA_MandC_base_calendar, set using Project->Project Info->Calendar
Working time: Mon-Fri, 9A-N, 13:00-15:00, set using Tools->Change Working Time
Working time defaults: 5 hrs/day, 25 hrs/week, 20 days/month, set using Tool->Options->Calendar
Fiscal year: starts in Oct
Holidays for Nov 2006 - Dec 2007 set in base calendar
Gantt Chart timescale: (Format->Timescale): top tier= Quater, by fiscal year, middle tier = month
(not fiscal year), bottom tier = week (not fiscal year)
Tools->Options->Calculation: Multiple Critical Paths box checked, display critical paths by selecting the Tracking Gantt view (there are other ways)

16 GUI version
As of 7/31/2006, the GUI version is ready for testing.  Will be used 1st on antenna 24.  Testing awaits readiness of antenna 24.

21 Single Ref Ptging tested & verified
Testing is sporadic with inconsistent results.  Problems with the antennas are giving rise to uncertainty as to whether or not reference pointing is actually working.

29 Ostream multicast of RTP data enabled
6/30/2006, Multicast of RTP data on the ostream has not yet been enabled, at Barry's request.  Barry will let Hichem know when he wants it turned on.  To turn it on will require only a download of a new 
configuration file that sets nonzero multicast rates for the data of interest.  I have set an arbitrary date (of 7/24) for when this data is to be enabled.

35 T305 ostream multicast of TP data tested
As of 8/1/2006, T305 multicast of Total Power Data has been enabled and tested on the bench.  This device will soon be moved into the field and placed in an antenna.

37 Automated Level Setting implemented
Finish date taken from EVLA Coord Mtng Target Dates of 7/17/2006.

38 Automated Level Setting Tested
9/14/2006: Auto level setting for the TP detectors, while basically done, can only be implemented for the AC side.  The BD side will not have the needed hardware until sometime early Q1 2008.  However, all of the 
software is in place.

43 Ethernet Control of EDFAs
10/23/2006: Item requested by Steve Durand on 10/23/2006.  The EDFAs connect to the Ethernet & can be controlled (& monitored?) over the Ethernet.  He would like to make this capability a part of the EVLA 
M&C System - has a manual, a CD with sample software, and sample hardware to work with is available.  He will get the manual & CD to me.

46 Deformatter bandpass
10/23/2006: Requested by Steve Durand.  Steve is referring to the real time bandpass capability that has been implemented by Mike Revnell & Carrie Shores.  The deformatter board has the ability to capture 
samples of the data coming from the antenna.  Mike & Carrie have written a Linux program that that loads this data from the deformatter, performs as FFT on the data and displays the result.  Steve would like to 
have this capacity a) integrated into the EVLA M&C system perhaps as something that can be used from the device browser, and b) available to both Linux & Windows users.

Walter Brisken is also working on some kind of software to look at the bandpass.  I have the impression that it does not necessarily use the samples captured by the deformatter, but it may, or it may use an 
accumulation of these samples and combine it with other meta-data making it potentially more useful than Mike & Carrie's tool.  What Walter is doing should be examined to avoid possivle duplication of effort.  

As of 10/23/2006, Walter's effort seems to be temporarily stalled.

49 Phased Array Operation
Finish date of 9/5/2006 taken from EVLA Cord Mtng Target Dates of 7/17/2006

53 Script stop
Currently, a script stop is honored only at source changes

54 Implement tipping curves for opacity determination
From EVLA Coord Mtng Target dates of 7/17/2006.

55 Write SNOW program to prevent snow accumulation
From EVLA Coord Mtng Target Dates of 7/17/2006.
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67 L353
6/30/2006, Keith Morris has informed Hichem that the board will be respun, with some additional MIB software work required to add monitor and control points.

Start date is arbitrays, a complete guess.
86  applications software development & testing

11/08/26:  Bruce probably not avail to work on vis pipe software until Jan 2008 due to correl prototype board support, vacation, M&C CDR, & holidays.

93 IDCAF software
8/4/2006, conversation with WalterBrisken
IDCAF components 
• a set of threads that collect information: alerts, visibility pipe data receiver, antenna property lists (subarray objects), things that happen every integration
• code to populate the archive record (most of the data strcutures are already in place)
• code that reads & writes the archive record format

There will likely be some small changes to the archive record format, requiring a bump to the version number and modification of the AIPS filler program.

Walter is shadowing Barry's work.  As Barry makes mods to the Executor, Walter adds to IDCAF.  Walter is willing to spend upto 50 % of his time (maybe more) over Aug thru Dec to make IDCAF happen.

101 M&C of VLA Antennas
11/29/2006: Initial tests using a 2 antenna array have been completed.  However, with the Modcomps still present testing is quite difficult.  Barry wishes to defer further testing until  Vis Pipe & IDCAF are sufficiently 
developed to allow the Modcomp computers to be taken offline while testing control of the VLA antennas.

107 Ability to handle 23 VLA Antennas evaluated
- Start date was arbitrarily chosen, but the software complete date is reasonably accurate.  The job is done and ready for more thorough testing.

109 Full test
Start date was arbitrarily chosen.

114 Final Tests/Debug of Control of VLA Antennas
8/3/2006  Barry stated that the central issue delaying the control of VLA antennas by the EVLA M&C system is the availability of someone to examine the results.

Barry does not want to work on controlling VLA antennas on a regular basis until he is also ready to work on controlling the VLA correlator.

116 M&C of VLA Correlator
8/4/2006, conversation with Ken: The 1 remaining issue that Ken sees a critical to regular use of the new correlator controller (under control of the Modcomps) is that the communications (transfer of data) from the 
array processor (AP) to Boss (a Modcomp computer) must be made more robust.  Once that goal is accomplished, the new correlator controller is ready for regular use & debugging in an operatioinal context.  

Work on the AP to Boss communications issue will be done on Fri, 8/11.  If that goes well, then the following week (week of 8/14) will be used for a long term test.  If the long term test is OK, then the correlator 
controller could be in regular use within another month or so, i.e., by the end of September2006.

11/29/2006: Barry has completed a successful test of control of the VLA correlator for continuum and correlator mode 1A.  However, with the Modcomps still present testing is quite difficult.  Barry wishes to defer 
further testing until  Vis Pipe & IDCAF are sufficiently developed to allow the Modcomp computers to be taken offline while testing control of the VLA correlator.

127 install system with more memory to ease screens freeze problem
See email from Ken Sowinski, 6Oct2006, Re:[Fwd:VLA Today] - that the rscreens pkg uses dynamic memory eventually fragmenting the memory pool and leading to a freeze up of the new correlator controller 
screens.

128 ? Converts rscreens to use statically allocated memory ?
It is not clear that this task will ever be undertaken.  The rescreens pkg that is used for the new correlator controller config, status, & control screens uses dynamically allocated memory that eventually leads to 
enough fragmentation in the VxWorks free memory pool that the screens freeze. 

129 Screen(s) for correlator derived self-products
8/4/2006:  Contrary to other information, Ken asserts that there is currently no screen for correlator derived self products.  A rscreens based display is possible, but has not been implemented.  Also, the self 
products are currently sent to Boss over ethernet.  A display program using the ethernet transmitted self products, be it Modcomp based or hosted by some other, ethernet connected system, is also possible.  No 
one is working on or even thinking about this need at this time.

134 Obs2script mods
8/4/2006:  Start date for obs2script mods in support of VLA correlator is a complete guess.  Bryan currently unavailable to ask.
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135 Interim Obs Exec mods
11/7/2006:  The estimated time assumes only one day per week of actual test time.  Might be best to create a special task calendar for this item for this item as in crash_modretire.mpp that reflects this restriction 
and then change the estimated work time to something on the order of 4 to 6 wks.

157 requirements (list of scrns & what is possible)
10/7/2006, Conversation with Rich Moeser:  My (WJS) request to him is that he produce a list of all AOI screens annotated as to which screens (or their equivalent) can actually be produced and which screens or 
portions of screens cannot be reproduced.  In some cases we will not be able to produce a screen becasue the needed information simply won't be available.

Figuring out the mapping of what fileds on a screen map to what information avaialble where in the system will be the hardest part.

Rich & I agree that having this task complete, coding and testing, at approx an 80% level by the end of January is a realistic goal.

161 "F" equivalent (display of Telcal (Antsol) results)
8/4/2006:  Chunai has completed work on a program that displays Antsol results as produced by ITelcal. Ken feels it is suitable as a replacement for the F display.  All that remains is for Rich to make some 
modifications to make Chunai's software suitable for the deployment environment and to then release it.

162 D10
8/4/2006, per KS:  Ken has a version of D10 that can run on igloo and access the realtime data stream.  However, it is not a production quality tool and he has no plans to develop it into one.  No one has been 
assigned to work on this item.

165 P10 display
P10 produces an (ascii) plot of spectra for line mode.  Ken has stated that he does not expect it ot be him who works on this task.  No one has been assigned to it.

176 Operational tools & issues
8/4/2006.  By "operational" tools & issues is meant all the tools and documentation (excluding antenna checkout & acceptance that are handled separately) the operators need to operate the array that are now 
provided by the Modcomps or are referenced to the Modcomp based system.

216 CMIB Device Layer User's Manual (10/5/06- Delayed, no start date)
10/5/06, Bruce Rowen:  Delaying this item.  No one, other than Bruce, is using or looking at the interface to the device layer right now.  No start date.

252 LTA Frame Save (format, implementation)
per Bruce Rowen, 10/5/2006:  LTA Frame Save refers to the ability to pull an LTA frame off the baseline board independent of sending it to the Ethernet output stage & on to the CBE.  Several purposes - 1) in case 
the ethernet transciever does not work,  2) to be able to look at raw correl frames independent of any further processing or changes made after the frame leaves the correl chip, and 3) provides the capability of 
wiritng frames directly to the LTA.

258 Correl Chip & Baseline Board Testing
Allow about 2 weeks between delivery of baseline board and the beginning of testig that uses the prototype board test software.

264 plotting capabilities needed for SB data products
Will this task be handled by the RTDD ?

267 Station Board Prototype Test SW
Finish date for Baeline Board testing taken from WIDAR_Correlator_Schedule.mpp of 28Jun2006.

272 FIR Filter (changes, 10/06)
10/5/06, Bruce Rowen: There have been changes to the timing chip & output chip that must be reflected in the device drivers.  Changes to the timing chip are fairly major.  Low level changes to the filter chip device 
driver will also be needed.

273 Output (changes, 10/06)
10/5/06, Bruce Rowen: There have been changes to the timing chip & output chip that must be reflected in the device drivers.  Changes to the timing chip are fairly major.  Low level changes to the filter chip device 
driver will also be needed.

274 Timing (changes, 10/06)
10/5/06, Bruce Rowen: There have been changes to the timing chip & output chip that must be reflected in the device drivers.  Changes to the timing chip are fairly major.  Low level changes to the filter chip device 
driver will also be needed.

275 VSI (VLBI IF - delayed, no start date)
10/5, Brcue Rowen: The VSI MAH refers to the VLBI (VLBI Stndrd Interface) Interface.  This item has been idefinitely delay, no start date.

279 Prototype Station Board HW
As of 22Jun2006, Brent Carlson is giving an estimated delivery data of late Sept for delivery of the prototype Station Board.

281 Assembled board to DRAO
Delay is board assembly due to long lead time on 1 component.
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10/25/2006: Still held up for a part - a connectior.  Carrying an 11/17 ship date if the connector arrives by Friday, 10/27/2006.
282 Station Board Testing 

Finish date for testing taken from WIDAR_Correlator_Schedule.mpp as of 28Jun2006.
292 Report on Alma BDF, suitability & needed mods

10/17/06, per Bryan Butler: Completion date for the report on the BDF is the end of Oct, and for the report on the ASDM is mid-Nov 2006.
298 Report on (A)SDM for PTC & Correl Data

10/17/06, per Bryan Butler: Completion date for the report on the BDF is the end of Oct, and for the report on the ASDM is mid-Nov 2006.
324 Config & Control

10/20/06, The System Level GUIs will reference Rack Level GUIs that will reference Board Level GUIs, that will reference chip level GUIs.  The Board & Chip Level GUIs will be the GUIs developed for testing the 
prototype boards.

328 Reviewed RFS for Test Builder, Executor & Analyzer
10/2006: The requirements & functional specs for the Test Builder & Test Executor have been defined in "Software Requirements For the Testing of the Board Prototypes, Rev 1.7, 2Oct2006, Vrcic & Rowen, 
A25204N0001

330 Test Executor SW
From correl telecon of Wed, 6/14/2006 - Brent has suggested that a Test Executorcapable of testing a collection of borads be ready in time for manufacturing functional tests (stage 3 production).  See meeting 
notes for further info.

344 CMIB Delay Models Software
10/5/2006, Bruce Rowen: Refers to themodels.  More specifically, to the software that does further transformation of the models - interpolation & the transmision of various portions to different places.

345 CMIB Phase Models Software
10/5/2006, Bruce Rowen: Refers to themodels.  More specifically, to the software that does further transformation of the models - interpolation & the transmision of various portions to different places.

355 Testing Workshop
From teleconn of Wed, 6/14/2006.  Brent is proposing a testing workshop, perhaps 2 weeks to 1 month in duration, at Penticton, after the prototype correlators have been assembled and loaded with software, but 
before they ship.  The purposes of the testing workshop would be 1) to exhaustively test the prototype correlators, and 2) to further train people in how the correlator works. 

373 Assembly & Testing
Start & Finish dates taken from WIDAR_Correlator_Schedule.mpp of 28Jun2006.
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